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Citing Sources:  APA Style 
(Social Sciences) 

 
NEW in 6th Edition 
 
What is a DOI (Digital Object Identifier)? 
A DOI is a unique number of four or more digits beginning with 10. A publisher assigns a DOI 
when an article is published and made available electronically. When DOIs are available, APA 
recommends including them in citations for both print and electronic sources.  
 
Where do I find the DOI? 

• Journal articles in research databases: You can look for the DOI in the database article’s 
citation information, document details, PDF view, or you may have to select a tab such as 
“Show Details” to see it.  

• Journal articles on web: The DOI is typically located on the first page of the article. 
• To check if a source has a DOI go to http://www.crossref.org/guestquery. 

 
Important Notes: 

• The Publication Manual of the American Psychological Association (6th ed.) states that 
citing the title of a subscription database is not necessary; however, APA’s Editorial 
Services director has stated in their APA Style blog that it is permissible to use database 
information if that best suits the purpose of leading the reader to the document being 
cited. She stated, “We understand that some universities adapt APA style for their needs 
and are supportive of institutions’ making exceptions to APA style when that is most 
effective” (http://blog.apastyle.org, Sept. 24, 2009 post by Paige Jackson, Comments, 
Nov. 6, 2009 reply). Wor-Wic’s research database source examples on pages 3-4 include 
the title of the database in addition to the DOI.  

• Do not include retrieval dates unless the source material may change over time (e.g., 
Wikis). 
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IN-TEXT PARENTHETICAL CITATIONS 
 
In-text citations provide at least the author’s last name and date of publication and at times a page number or paragraph number. 
Publication information about the source is given at the end of the paper (see list of references on page 2). Use these formats to give 
credit in the text to quotes and paraphrases of words and ideas. The following in-text examples are from Documenting Sources in APA 
Style: 2010 Update. (2010), retrieved from http://lrcsubjects.pbworks.com/f/Documenting+Sources+in+APA+Style.pdf and APA 
Style Blog: How Do I Cite a Kindle? (Sept. 15, 2009), retrieved from http://blog.apastyle.org/apastyle/2009/09/how-do-i-cite-a-
kindle.html 
 
EXACT QUOTE 
Critser (2003) noted that despite growing numbers of overweight Americans, many health care providers still “remain either in 
ignorance or outright denial about the health danger to the poor and the young” (p. 5). 
 
Notes:  If the author is not named in the sentence, place the author’s name, the year, and the page or paragraph number in parentheses 
after the quotation: (Critser, 2003, p. 5).  
 
If neither page or paragraph number is visible, cite a heading and the number of the paragraph following it. A shortened heading title 
can be used if the heading is long: (Hoppin & Taveras, 2004, Weight-Loss Drugs section, para. 6). 
 
For a Kindle, Nook or other eBook reader that has numbered chapters and sections but no numbered pages: (Gladwell, 2008, Chapter 
1, Section 2, para. 5). 
 
SUMMARY OR PARAPHRASE 
Obese children often engage in less physical activity (Sothern & Gordon, 2003, p. 104). 
 
Note:  Provision of page number (p.) or paragraph (para.) is encouraged to help reader locate relevant passage.. 
 
A WORK BY MULTIPLE AUTHORS 
In 2003, Berkowitz, Wadden, Tershakovec, and Cronquist concluded, “Sibutramine . . . must be carefully monitored in adolescents, as 
in adults, to control increases in [blood pressure] and pulse rate” (p. 1811). 
 
As Berkowitz et al. (2003) advised, “Until more extensive safety and efficacy data are available, . . . weight-loss medications should 
be used only on an experimental basis for adolescents” (p. 1811). 
 
Note:  For two authors, cite both names every time the reference occurs in text. For three to five authors, identify all authors the first 
time you cite the source; after that, use the first author’s name followed by “et al.” and the year. For six or more authors, cite only the 
first author’s surname, followed by “et al.” and the year for the first and subsequent citations. An ampersand (&) can be used to join 
two names in parenthetical material, but the word “and” needs to be used in the text. 
 
UNKNOWN AUTHOR 
Children struggling to control their weight must also struggle with the pressures of television advertising that, on the one hand, 
encourages the consumption of junk food and, on the other, celebrates thin celebrities (“Television,” 2002). 
 
Note:  Give the first few words of reference list entry (usually the title) and the year. Use quotation marks around the title of an article,  
chapter, or webpage and italicize the title of a periodical, book, brochure or report. 
 
ELECTRONIC DOCUMENT 
Cite an electronic document as you would any other document. When no page numbers are given, follow the examples given above 
under Exact Quote and Paraphrase. When the date is unknown, use the abbreviation “n.d.” 
 
PERSONAL COMMUNICATION 
One of Atkinson’s colleagues, who has studied the effect of the media on children’s eating habits, has contended that advertisers for 
snack foods will need to design ads responsibly for their younger viewers (F. Johnson, personal communication, October 20, 2004). 
Note:  Do not include personal communications such as interviews, personal email, memos and letters in references list.  
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These guidelines are from the Publication Manual of the American Psychological Association (6th ed.). (2010). Washington, D.C.: 
American Psychological Association. Reference copies of the APA Manual and sample papers can be found in the Media and 
Resource Centers (AAB217, HH 00, GH204, and WDC305).  
 
For online sample papers, see http://search.apastyle.org//?query=&facet=stylecontenttype:Sample paper 

 
FORMATTING THE PAPER 

 
Typed, double-spaced, 12 point Times New Roman, Courier or other serif font, 8.5 X 11 inch white paper, uniform margins of at least 
1 inch on all sides, paragraphs indented ½ inch or 5-7 spaces. 
 
RUNNING HEAD AND PAGE NUMBERS:  Short version of your title in all uppercase letters flush left at top of all pages; 
consecutive page numbers in top right on all pages, including title page.  The words “Running head” are used before head on title page 
only. 
 
Page 1 header: 

1. Press CTRL+Home on the keyboard to move to the beginning of the document. 
2. On the Insert tab, click Header, then Edit Header (near the bottom of the menu). 
3. On the Header & Footer Tools Design tab, click Different First Page to place a check in the box, then click the Page Number button, 

choose Top of Page, and Plain Number 1. 
4. On the left side of the number 1, type “Running head:” (without the quotes and with an uppercase ‘R’ and the rest lowercase). After the 

colon, type a space, and a short version of the title in all uppercase letters. Example:  Running head: SHORT TITLE OF PAPER 
5. Press the TAB key on the keyboard once or twice to move the page number to the right margin. 
6. If needed, select the text in the header and set the font type and size to the same font and size used in the rest of the paper. 

Subsequent page headers: 
7. Select all of the text in the header on page 1 including the page number. 
8. On the Home tab, click the Copy button. Scroll to page 2 and click in the header. 
9. On the Home tab, click the top portion of the Paste button. 
10. Delete the text “Running head:” and the space. Double click out of the header to close. 

 
TITLE PAGE:  Page number 1 in top right corner with remaining pages numbered consecutively; includes running head at top left;  
title, writer’s name, and institution name, centered and double-spaced, about 1/3 of the way down the page; some instructors may 
require course name and number, instructor’s name, and date, centered and double-spaced near the bottom of the page. If an author 
note is required, include departmental affiliation, acknowledgments, special circumstances, and personal contact information.  See 
sample title page on page 4. 
 
ABSTRACT:  If your instructor requires an abstract (paragraph giving brief summary of paper), it follows the title page, double-
spaced with the word Abstract centered. 
 
PUNCTUATION: Two spaces after punctuation of sentence; one space after commas, colons, semicolons and periods in initials and 
reference citations. 
 
LONG QUOTATIONS:  If longer than 40 words, set it off by indenting ½ inch or 5 spaces, double-spaced, no quotation marks 
needed. 
 
HEADINGS IN THE TEXT:  Major headings are centered and boldface with important words capitalized; second-level headings are 
flush left, boldface with important words capitalized. 
 
TABLES AND FIGURES:  Graphs, charts, drawings, etc. For tables and figures use Table 1, Table 2, etc. or Figure 1, Figure 2, etc. 
on separate lines above table, source given below table following the word “Note” and a period. 
 
LIST OF REFERENCES:  Double-spaced on a separate page at end of paper, with word “References” centered; alphabetized by last 
names of authors, editors, or first word of the title other than A, An, or The. (Note: Only begin an entry with Anonymous if the 
work is signed Anonymous).  If two or more works are by same author, arrange by earliest date first. Use a hanging indent: first line 
is flush left, additional lines are ½ inch or 5-7 spaces from left. When a URL must be divided, break it after a slash or before a period 
(do not use hyphen). See the sample list of references on page 5, followed by models and examples for different types of entries on 
pages 6-10. 
 
Note:  Citations are given in most research database articles; however, all may not be totally accurate. For additional help with 
individual citations, you may want to use NoodleBib Express at www.noodletools.com. Under free software tools, select NoodleBib 
Express, then APA. 
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Running head: LESSONS FROM KATRINA 
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LESSONS FROM KATRINA 

References 

Associated Press (photographer). (2005, September 2). Katrina, Hurricane: Red Cross volunteer comforting a 

victim of Hurricane Katrina [Photograph]. Retrieved from Encyclopedia Britannica Online database. 

Dietrich, J. C., Bunya, S. S., Westerink, J. J., Ebersole, B. A., Smith, J. M., Atkinson, J. H., . . . Roberts, H. J. 

(2010). A high-resolution coupled riverine flow, tide, wind, wind wave, and storm surge model for 

southern Louisiana and Mississippi. Part II: Synoptic description and analysis of Hurricanes Katrina and 

Rita. Monthly Weather Review, 138, 378-404. Doi: 10.1175/2009MWR2907.1 Retrieved from 

Academic Search Complete database. 

Films Media Group (Producer). (2006). The lost city of New Orleans: A case study [Video]. Retrieved from 

Films on Demand database. 

Hurricane. (2008). In The Columbia Encyclopedia. New York: NY: Columbia University Press. Retrieved from 

Credo Reference database. 

Kaper, S. (2006, June 16). Katrina hindsight produces banks’ list for next time. American Banker, 171( 3), 3. 

Retrieved from General Reference Center Gold database. 

The Katrina files. (2009). Times-Picayune. Retrieved from http://www.nola.com/katrina/view.ssf 

Kutner, N. G., Muntner, P., Yijian, H., Zhang, R., Cohen, A. J., Anderson, A. H., & Egger, P. W. (2009). Effect 

of Hurricane Katrina on the mortality of dialysis patients. Kidney International, 76, 760-766. Doi: 

10.1038/ki.2009.268 Retrieved from CINAHL Plus with Full Text database. 

Marek, A.C. (2006, June 5). Learning the hard lessons of Katrina. U.S. News & World Report, 140(21), 32-34. 

Retrieved from Business Source Premier database. 

Stoker, J.M., Tyler, D.J., Turnipseed, D.P., Wilson, K.V., & Oimoen, M.J. (2009). Integrating disparate lidar 

datasets for a regional storm tide inundation analysis of Hurricane Katrina. Journal of Coastal Research, 

25(6), 66-72. doi: 10.2112/SI53-008.1 Retrieved from ProQuest Central database. 
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REFERENCE LIST EXAMPLES 
 
 

RESEARCH DATABASE SOURCE 
 

Type 
 

 

Example 
Double space and alphabetize citations in your actual reference list. Use author’s last name, followed by 
initial(s) only. Journal title and volume numbers are placed in italics. Capitalize only the first word of title 
and subtitle and all proper nouns. When no author is given, start the citation with the article or entry title. 
Use n.d. in parentheses if no date is available.                      See notes about DOI on page 1. 

Journal article from research 
database when DOI is available 
 
Volume number is italicized. 
Only give issue number (not 
italicized) in parentheses after 
volume if each issue begins on page 
1. (See Leutwyler example) 
 
Capitalize first word of title, first 
word after a colon and proper 
nouns. 
 
In the Kendall ex., the DOI was 
given in the PDF view of the article. 

Authors’ last names, initial(s). (year). Article title. Journal title, vol. (issue if applicable), page(s). doi when 

available Retrieved from database title followed by the word database. 

 Sen, B., & Campbell, C. (2010). Alcohol prevalence, alcohol policies, and child fatal injury rates from motor 

vehicle crashes. Contemporary Economic Policy, 28, 392-405. doi: 10.1111/j.1465-

7287.2009.00142.x Retrieved from Academic OneFile database. 

Leutwyler, H., & Wallhagen, M. (2010). Understanding physical health of older adults with schizophrenia: 

Building and eroding trust. Journal of Gerontological Nursing, 36 (5), 38-45. doi: 

10.3928/00989134-20091103-99 Retrieved from CINAHL Plus with Full Text database. 

Kendall, K., Stetz, J., Roon, D., Waits, L., Boulanger, J., & Paetkau, D. (2008). Grizzly bear density in 

Glacier National Park, Montana. Journal of Wildlife Management, 72(8), 1693-1705. doi: 

10.2193/2008-007 Retrieved from ProQuest Biology Journals database. 

Journal article from research 
database when DOI is not 
available 
DOIs can be searched for at 
www.crossref.org/guestquery/  
when not given in database 

Authors’ last names, initial(s). (year). Article title. Journal title, vol. (issue if applicable), page(s). Retrieved 

from database title followed by the word database. 

O'Malley, P. M, & Johnston, L.D. (2007). Drugs and driving by American high school seniors, 2001-2006. 

 Journal of Studies on Alcohol and Drugs, 68, 834-842. Retrieved from Health and Wellness 

Resource Center database.  

Journal article from research 
database with more than seven 
authors 
 
List six authors, three ellipsis points, 
and last author. 
When a reference has up to seven 
authors, spell out all authors’ names  
 

Authors’ last names, initial(s). (year). Article title. Journal title, vol. (issue if applicable), page(s). doi when 

available Retrieved from database title followed by the word database. 

Bloemen, O.J.N., de Koning, M.B., Schmitz, N., Nieman, D.H., Becker, H.E., de Haan, L., . . . van 

Amelsvoort, T.A.M.J. (2010). White matter markers for psychosis in a prospective ultra-high-risk 

cohort. Psychological Medicine, 40, 1297-1304. doi: 10.1017/S0033291709991711 Retrieved from 

ProQuest Psychology Journals database. 

Magazine article from research 
database 
 

Author’s last name, initial (s). (year, month day). Article title. Magazine title, vol., (issue number), page(s). 

doi when available Retrieved from database title followed by the word database.  

Phillips, Z. (2010, June 21). Oil firms under pressure from insurers, Congress.  Business Insurance, 44 (25), 

1. Retrieved from General Reference Center Gold database.  

Newspaper article from research 
database 
 
Use pp. for multiple pages. 
 

Author’s last name, initial(s). (year, month, day). Article title. Newspaper title, page(s). Retrieved from 

database title followed by the word database.  

Fausset, R. & Santa Cruz, N. (2010, July 14). Test for well cap is delayed: Device could ultimately stop oil 

leak. Chicago Tribune, p. 12. Retrieved from ProQuest Newstand database.   
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RESEARCH DATABASE SOURCE CONT’D. 
 

Type 
 

/  

 

Example 
Double space and alphabetize citations in your actual reference list. Use author’s last name, followed by 
initial(s) only. Journal title and volume numbers are placed in italics. Capitalize only the first word of title 
and subtitle and all proper nouns. When no author is given, start the citation with the article or entry title. 
Use n.d. in parentheses if no date is available. 
See notes about DOI on page 1. 
 

Reference book article from 
research database 
 
Begin with entry title when there is 
no author. Volume and pages are 
not always given in the databases. 
Use  Rev. ed. for revised edition. 
 
 

Author’s last name, initial(s). (year). Entry title. In initial(s). Last name of editor(s) (Ed(s). Book title (edition 

or volume if given) (pages). City, State: Publisher. Retrieved from database title followed by the 

word database. 

Spiwak, A.J. & Davidson, T. (2009). Aortic aneurysm repair. In B. Narins (Ed.), Gale 

encyclopedia of surgery and medical tests (2nd ed.). Detroit, MI: Gale. Retrieved from 

Health and Wellness Resource Center database. 

Population growth. (2008). In W. Darity Jr. (Ed.), International encyclopedia of the social sciences 

(2nd ed., Vol. 6, pp. 378-381). Detroit, MI: Macmillan Reference USA. Retrieved from 

Global Issues in Context database. 

Video/motion picture/DVD from 
research database 
 
Begin with title when no contributor 
is given. 

Primary contributor if available last name, initial(s). (Producer/Director/Writer) (Year). Title [Video/Motion 

picture/DVD]. Retrieved from database title followed by the word database. 

Local Broadcast Video Content (Producer). (2010). Local boy raises money for the Gulf  [Video]. Retrieved 

from General Reference Center Gold database. 

Podcast from research database Producer if available last name, initial(s). (Producer). (Year or year, month day). Title [Podcast]. Series title. 

Retrieved from database title followed by the word database. 

BP says it will pay for Gulf Coast oil spill cleanup [Podcast]. (2010, May 3). The Online NewsHour. 

Retrieved from Academic OneFile database. 

Map/artwork/photo from 
research database 
 

Cartographer/Artist/Photographer’s last name, initial(s). (year or year, month day). Title or description 

[Descriptive label]. Retrieved from database title followed by the word database. 

Sisco, A.J. (Photographer). (2010, May 31). Oiled pelican struggles to fly as BP oil spill impacts wildlife near 

Venice, Louisiana, UPI Photo Collection [Photo]. Retrieved from Academic OneFile database.  
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INTERNET SOURCE 
 

Type Example 
Double space and alphabetize citations in your reference list. Use author’s last name, followed by initial(s) 
only. Journal title and volume numbers are placed in italics. Capitalize only the first word of title and subtitle 
and all proper nouns. Break a URL before most punctuation; do not use a hyphen or add a period. 
 
See notes about DOI on page 1. 

 
Nonperiodical document from 
Internet 
 
No period at the end. Use n.d. when 
no date is given. Begin with 
document title when there is no 
author given. 

Author’s last name, initial(s) when possible. (year). Document title or description. Retrieved from URL of 

source website 

Strickland, J. (2007, October 27). How hackers work. Retrieved from http://computer.howstuffworks 

.com/hacker.htm# 

Centers for Disease Control and Prevention, National Center for Chronic Disease Prevention and Health 

Promotion. (2010). Basics about diabetes. Retrieved from http://www.cdc.gov /diabetes 

/consumer/learn.htm 

Enhance your memory. (n.d.). Retrieved from http://www.apa.org/topics/learning/enhance-memory.aspx 

Source from an university 
program’s website 

Author’s last name, initial(s). (year). Document title. Retrieved from the name of the university, name of 

program website: URL of source website. 

Washington, George (1796). Washington’s farewell address 1796. Retrieved from the Yale University Law 

School, Lillian Goldman Law Library, Avalon Project website: http://avalon.law.yale.edu/default.asp 

An Internet article based on a 
print source 
 
 
 
 

Author’s last name, initial(s). (year). Article title. Publication title, volume (issue number if applicable) doi if 

available or Retrieved from URL of source website 

Novotney, A. (2010, July). Life-changing interventions. Monitor on Psychology, 41 (7). Retrieved from 

http://www.apa.org/monitor/2010/07-08/interventions.aspx 

Article in an Internet-only journal 
 
 
 

Author’s last name, initial(s). (year, month day). Article title. Journal title, volume, Article number if 

applicable. doi if available or Retrieved from URL of source website  

Lennon, B. (2009, January). New media critical homologies. Postmodern Culture, 19 (2). doi: 

10.1353/pmc.o.0049 

Entry in an online dictionary or 
encyclopedia.  
 
Include edition number when online 
version derives from print source. 

Entry word(s) (year). In online source title. doi if available or Retrieved from URL of source website. 
 

Aeronautics. (2010). In Merriam-Webster online dictionary. Retrieved from  

                http://www.meriam-webster.com/dictionary/aeronautics 

Government report or publication Author’s last name, initial(s) or name of organization or agency. (year). Title (report or publication number). 

Retrieved from URL of source website 

U.S. Department of Health and Human Services, National Institutes of Health, National Institute on Aging, 

Alzheimer’s Disease Education & Referral (ADEAR) Center. (2010). Alzheimer’s disease fact sheet 

(NIH Publication No. 08-6423). Retrieved from http://www.nia.nih.gov/Alzheimers 

/Publications/adfact.htm 

Paper presented at a conference 
or symposium  
 
If proceedings are published follow 
format for book or journal 

Presenter/contributor’s last name, initial(s). (year). Paper title. Paper presented at the meeting or symposium 

title, Location.  

Woll, C. (2006). The difficult organization of business interests: Lessons from the French case. Paper 

presented at the International Conference of the Council for European Studies, Chicago. Retrieved 

from http://www.ces.columbia.edu/pub/papers/woll.pdf 

Video on a website Producer’s or other primary contributor’s last name, initial. (Producer). (year). Title [Video]. Retrieved from 

URL of source website 

ABQCVB (Producer). (2007). A typical hot air ballooning day in Albuquerque, NM [Video]. Retrieved from 

http://www.youtube.com/watch?v=Vyt8D8maDc 
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INTERNET SOURCE CONT’D. 

 
 

Type Example 
Electronic posts or comments on a 
website or electronic mailing list 
 
Description examples: Electronic 
mailing list message, Online forum 
comment, Web log comment, Web 
log post. 

Author’s last name, initial(s) or nickname/screen name. (year, month day). Title [Description of form]. 

Retrieved from URL of source website 

Lee, Chelsea. (2009, September 21). A DOI primer [Web log post]. Retrieved from 

http://blog.apastyle.org/apastyle/2009/09/a-doi-primer.html 

Map/artwork/photo on a website 
 
Begin with title of work if no 
contributor is given. 
 

Cartographer/artist/photographer’s last name, initial(s). (Year or year, month day image was created). Title or 

description [Descriptive label]. Retrieved from URL of website 

O’Keeffe, G. (Painter). (1930). Black, white and blue [Image of oil painting]. Retrieved from http://www.nga 

.gov/cgi-bin/pimage?105872+0+0 

CIA Maps & Publications (Cartographer). (2009). Afghanistan-Pakistan Administrative Divisions [Map 

#777768]. Retrieved from https://www.cia.gov/library/publications/cia-maps-publications 

/afghanistan.html 

Downloadable electronic book 
 
Use n.d. when no date is given. 

Author’s last name, initial(s). (year). Book title [Type of eBook reader or device followed by the 

word version]. Retrieved from URL of website from which you downloaded or store 

name 

Whitney, E.N. & Rolfes, S.R. (2010). Understanding nutrition [Kindle version]. Retrieved from 

http://www.amazon.com 

Chin, R. (Ed.). (2008). Emergency management of infectious diseases [iPhone/iPad version]. 

Retrieved from http://www.ebooks.com 

 
AUDIOVISUAL SOURCE 

 
Type 

 
Example 

Double space and alphabetize citations in your reference list. Use author’s last name, followed by initial(s) 
only. Journal title and volume numbers are placed in italics. Capitalize only the first word of title and subtitle 
and all proper nouns. 
 

Film/video/DVD 
Identify as “Motion picture” in 
brackets; give director, producer, or 
both. APA does not give separate 
guidelines for videos or DVDs. 
Include name/address of distributor 
if motion picture is difficult to find.  
 

Producer’s or other primary contributor’s last name, initial. (Producer), and Director’s or other relevant 

contributor’s last name, initial. (Director). (year). Title [Motion picture]. Country: Studio. 

Schaffner, F. (Director). (1970). Patton [Motion Picture]. United States: 20th Century Fox. 

Wright, J. (Director), & Moggach, D. (Screenwriter). (2006). Pride & Prejudice [DVD]. United States:   

Universal. 

Music recording  Writer’s last name, initial. (copyright year). Title of song [Recorded by artist if different from writer]. On 

Title of album [Medium of recording: CD, record, cassette, etc.]. Location: Label. (Recording year if 

different from copyright year). 

Bach, J.S. (2009). Violin concerto no. 1 in A minor, BWV 1041-1 (allegro moderato) [Recorded by Julia 

Fischer]. On  Bach: Violin concertos [CD]. London, England: Decca. 

Television program Writer’s last name, initial. (Writer), & Director’s last name, initial. (Director). (year). Title [type of work]. In 

initial. Producer’s last name (Producer), Title of series. City: Production company. 

Chase, D. (Writer), & Van Patten, T. (Director). (2001). Proshai, Livushika [Cable television series episode]. 

In D. Chase (Producer), The Sopranos. New York, NY: HBO. 
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PRINT SOURCE 

 
Type 

 
Example 

Double-space and alphabetize citations in your actual reference list. Use author’s last name, followed by 
initial(s) only. Titles and volumes are italicized. Capitalize only the first word of title and subtitle and all 
proper nouns. When available, include DOI for print and electronic sources (see DOI note on page 1). 
 

Book by Single Author  
 
Give state if city is not well known.  
For a book with an editor but no 
author, use “Ed.” or “Eds.” in 
parenthesis after the editor’s name. 
Include edition if revised. 

Author’s last name, initial(s). (year). Book title. City, State: Publisher. 

 

Hacker, D. (2006). Research and documentation in the electronic age (4th ed.). New York, NY:  

Doubleday/Currency. 

 
Book by Two or More Authors 
 
 List all authors up to six, then for 
subsequent authors abbreviate as 
et.al. (see Bloemen ex. on page 3). 
 

Authors’ last names, initial(s). (year). Book title. City, State: Publisher. 
 
Berman, B., & Lanza, R. (2010). Biocentrism: How life and consciousness are the key to understanding the 

true nature of the universe. Dallas, TX: BenBella Books. 

Book with No Author or Editor 
Given 
Use Anonymous if a work’s author 
is designated as anonymous. 
 

Book title. (edition if applicable). (year). City, State: Publisher. 

Publication manual of the American psychological association. (6th ed.). (2009). Washington, DC: American 

Psychological Association. 

Chapter in a Book  
 
If the book has editors, use Eds. in 
parentheses after the names. 

Author’s last name, initial(s). (year). Title of work. In initial(s). Last name of author. Book title (edition if 

applicable) (pages). City, State: Publisher. 

Varcarolis, E.M. (2010). The nursing process and standards of care for psychiatric mental health nursing. In 

E.M. Varcarolis and M.J. Halter, Foundations of psychiatric mental health nursing (pp. 138-155). 

St. Louis, MO: Saunders Elsevier. 

Article in a Reference Book 
 
 
 
Begin with entry title when 
no author is given. Proper nouns are 
capitalized. 
 

Author’s last name, initial(s). (year). Title of article. In initial(s). Last name of editor(s) (Eds.), Book title 

(edition, volume if applicable, pages). City, State: Publisher. 

McGee, G. Human cloning. (2005). In C. Mitcham (Ed.), Encyclopedia of science, technology, and ethics 

(Vol. 2, pp. 938-942). Detroit, MI: Macmillan Reference USA. 

Civil War time line. (2009). In M.E. Wagner, G.W. Gallagher, P. Finkelman (Eds.), The Library of Congress 

Civil War desk reference (pp. 1-6). New York, NY:  Simon & Schuster. 

Article in a Journal 
Give issue number in parenthesis 
after volume if each issue is paged 
separately (begins with page 1). 
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